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License

The following END USER LICENSE AGREEMENT applies to the optiDesigner
software package (the “SOFTWARE”).

This End-User license Agreement ("EULA”) is a legal agreement between you (the
“USER?” - either an individual or a single entity) and Elad Salomons (the “AUTHOR”)
for the use of the SOFTWARE. By installing, copying, or otherwise using the
SOFTWARE, you agree to be bound by the terms of this EULA.

Trial Version

The trial (Shareware) version of this software may be used for evaluation purposes at
the USER's own risk for a period of 30 days from the date of installation. At the end of
the trial period, the USER must either purchase a license (register) to continue using the

software, or remove it from his/her system.

Registered (Commercial) Version

GRANT OF LICENSE. The SOFTWARE PRODUCT is protected by copyright laws
and international copyright treaties, as well as by other intellectual property laws and
treaties. The SOFTWARE is licensed, not sold. You may install and use the
SOFTWARE on a single computer.

COPYRIGHT. All right, title, and copyright in and to the SOFTWARE and any copies
of the SOFTWARE, are owned by the AUTHOR. The SOFTWARE is protected by
copyright laws and international treaty provisions. Therefore, you may either (a) copy
the SOFTWARE solely for backup or archival purposes, or (b) install the SOFTWARE
on a single computer provided you keep the original solely for backup or archival
purposes. You may not copy the printed materials which might accompany the

SOFTWARE.

LIMITED WARRANTY. The AUTHOR warrants that in the case of a CDROM disk
being sent to you, the original distribution media is free from defects for 90 days from
the date of delivery of the SOFTWARE. This limited warranty does not apply in the
case of online download of the SOFTWARE.

NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, the
AUTHOR expressly disclaims any warranty for the SOFTWARE. The SOFTWARE

-3



and any related documentation is provided "as is" without warranty of any kind, either
express or implied, including, without limitation, the implied warranties or
merchantability of fitness for a particular purpose. The entire risk arising out of use or

performance of the SOFTWARE remains with you.

LIMITATION OF LIABILITY AND CUSTOMER REMEDIES. The AUTHOR’s
entire liability and your exclusive remedy under this EULA shall be, at the AUTHOR’s
option, either (a) return of the price paid for the SOFTWARE or (b) replacement of the
SOFTWARE which does not meet the AUTHOR’s Limited Warranty and which is
returned to the AUTHOR’s with a copy of your receipt. Any replacement SOFTWARE
will be warranted for the remainder of the original warranty period or 30 days,

whichever is longer.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent
permitted by applicable law, in no event shall the AUTHOR be liable for any damages
whatsoever (including, without limitation, damages for loss of business profit, business
interruption, loss of business information, or any other pecuniary loss) arising out of the
use or inability to use this product, even if the AUTHOR has been advised of the
possibility of such damages. Because some states/jurisdictions do not allow the
exclusion or limitation of liability for consequential or incidental damages, the above

limitation may not apply to you.



Introduction

What is optiDesigner

optiDesigner is a Windows software for the optimal design of water distribution
networks using “Genetic Algorithms” (see bellow). The program uses EPANET (a
hydraulic simulator distributed by the US EPA) for the drawing and analyzing the
system. optiDesigner will design the network pipes and find their minimal cost

under a set of constraints, which includes:
® Minimal and maximal pressures at networks nodes.
e Minimal and maximal velocities at networks pipes.

e Maximal sources flow.

With optiDesigner you can find the most cost effective design, rehabilitation and

expansion of your water distribution system.

But, if you are looking for a software that, on a push of a button, will design a
water distribution system with no engineering work done by you, optiDesigner is
not for you. optiDesigner can not replace the engineer; it could only help him!
Every piece of data that you enter into the model should be considered carefully
since the algorithm can not think for you. What it does, is only search (of course in

a smart way) the vast space of design possibilities.

Having said that we are ready to proceed with optiDesigner.

What are Genetic Algorithms?

Genetic algorithms were invented by Holland to mimic some of the processes of natural
evolution and selection. In nature, each species needs to adapt to a complicated and
changing environment in order to maximize the likelihood of its survival. The

knowledge that each species gains is encoded in its chromosomes, which undergo
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transformations when reproduction occurs. Over a period of time, these changes to the
chromosomes give rise to species that are more likely to survive, and so have a greater
chance of passing their improved characteristics on to future generations. Of course, not

all changes will be beneficial but those that are not tend to die out.

Holland's genetic algorithm attempts to simulate nature's genetic algorithm in the
following manner. The first step is to represent a legal solution to the problem you are
solving by a string of genes that can take on some value from a specified finite range or
alphabet. This string of genes, which represents a solution, is known as a chromosome.
Then an initial population of legal chromosomes is constructed at random. At each
generation, the fitness of each chromosome in the population is measured. The fitter
chromosomes are then selected to produce offspring for the next generation, which
inherit the best characteristics of both the parents. After many generations of selection
for the fitter chromosomes, the result is hopefully a population that is substantially fitter

than the original.

Steps in using optiDesigner

The following steps are to be taken for the use of optiDesigner:
1. Draw the system using EPANET and set systems properties.
2. Export the network from EPANET as an INP file.
3. Start a new project within optiDesigner and select the INP file.
4. Define the design options.
5. Set the pipes to be designed.
6. Set constraints.
7. Set optimization parameters.
8. Run the simulation.

9. View results using EPANET.



Quick start

Installing optiDesigner

optiDesigner is designed to run under the Windows 95 (and higher) operating system. It
is distributed as a single file, optiDesignerl.exe, which contains a self-extracting setup

program. To install optiDesigner:
1. Select Run from the Windows Start menu.
2. Enter the full path and name of the optiDesigner1.exe file.
3. Click the OK button type to begin the setup process.

4. Follow the instructions of the setup program.

Should you wish to remove optiDesigner from your computer, you can use the
Add/Remove option in the Control Panel (Be sure to read the registration matters in

this manual before removing optiDesigner.

Hardware and Software requirements

Hardware

In general, optiDesigner needs as much computer power as you can supply.
optiDesigner was tested on machines with at least 128MB RAM and 750MHz Pentium
II processor. The software can be used on machines with less memory and slower

processors but it will reflect on the software performance (run time).

The optimization process may take minutes and even more then an hour depends on the
system being designed. The more RAM and processor power you have, the optimization

process will take less time.

Software
Beside the software it self, you will need a copy of EPANET Ver. 2.00.08 or version

-7 -



2.00.09. It can be downloaded freely from the following site:

http:/www.epa.gcov/ORD/NRMRL/WSWRD/epanet.html

Example tutorial

In this chapter we will solve a simple optimization problem taken from:
"Design of optimal water distribution systems" by E. Alperovits and U. Shamir, 1977.

The network file (INP file) is located in the “Tutorial” sub-directory in the directory you
installed optiDesigner in (by default: C:\PROGRAM FILES\OPTIDESIGNER).

Consider the network in the “tutorial.inp” file, which has eight pipes of 1000 meters
length each, arranged in two loops and is fed by gravity from a constant head reservoir.
The demands are given in the data table below and the head at each node is to be at least
30 meters above the ground elevation of the node. The pipe costs, per unit length, are

given in the table below. Chw is 130 for all pipes.

Nodes data:
Node Demand | Elevation
(CMH) (m)

1 -1120 210
2 100 150
3 100 160
4 120 155
5 270 150
6 330 165
7 200 160




Pipes costs:

Diameters | Unit cost
(")

1 2

2 5

3 8

4 11

6 16

8 23

10 32

12 50

14 60

16 90

18 130

20 170

22 300

24 550

To solve this problem start optiDesigner and:
1. Select “New” from the “File” menu and chose the “Tutorial.inp” file.

2. You will see the following screen:



optiDezigner - [Map]

Df|e| mle[~] | ][4

3. To save the design project click the “Save” option from the “File” menu and give

the project a name (“Tutorial.od”).

4. To enter the design options select “Design Manager” from the “Design Option”

menu:
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Dezign Manager x|

Add B ow [Delete How
Cost For
1D Description pipe unit | Diameter HDEEE;;ESS
length )

Export ..
IO I
Dezcription I il .
Cost for pipe unit length I
Diarneter I (]
Roughhess coeff. I Update |

Cancel

5. Click the “Import...” button and select the predefined file named

“Design_options.dat” located in the “Tutorial” directory:
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£ Design Manager x|

Add B ow [Delete How
Dot Mew 1 in pipe 2 254
poz Mew 2 in pipe ] A0.8 130
Do3 Mew 3 in pipe 8 762 130
Do4 Mew 4 in pipe 11 101.E 130
D& Mew B in pipe 16 152 4 130
DOE Mew 8 in pipe 23 203.2 130
Dov Mew 10 in pipe 32 254 130
Dog Mew 12 in pipe 50 304.8 130
DoA Mew 14 in pipe 0 KialaNs 130 &
I Do1
Description INEW 1 in pipe
Cost for pipe unit length I 2
Diarneter a5 4 ak.
Roughhess coeff. 130 Update |
Cancel

6. Click the “OK” button.

7. To enter the junctions options select “Junctions...” from the “Design Option”

menu:
Junctions Design Manager - |EI|5|
|lpdate all junctions Min prezsure
Junction 1D Min. pressure Max. pressure
Update all junctions M ax preszure
2
3 1] 1]
4 1] 1]
0]
5 0 0 2
g g g Mir Pressure i
P ax Pressure i
[T Design Update

Cancel
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8. Since a minimal pressure of 30m is to be kept for junctions click the “Update all

junctions Min pressure” button and enter 30.

9. Since there is no maximal pressure to be kept click the “Update all junctions

Max pressure” button and a high value — 1000.

& Junctionz Dezign Manager O] x|
|lpdate all junctions Min prezsure |
Junction 1D Min. pressure Max. pressure

2 a0
3 a0 1000
4 a0 1000 D
5 30 1000 2
b a0 1000 .
= a0 1000 Mir Pressure an

P ax Pressure 1000

[T Design Update

] Cancel

10. Now click each line in the table and check the “Design” check box for each

junction. Make sure you click the “Update” button for each junction:

£ Junctions Design Manager =I0l

IJpdate all junctions Min prezsure
Junction ID Min. pressure Max. pressure
Update all junctions Max preszure
2 a0
3 a0
4 a0
I
5 30 7
G a0 .
7 a0 Min Preszure a0
Max Pressure 1000
v Design

k. Cancel

11. Click the “OK” button.
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12. To enter the pipes options select “pipes...” from the “Design Option” menu:

Pipez Desagn M anager » .-.lﬂ]ﬂ

Update al piges e vekocy |
Pipe 1D Min, welocity | Max velocily
Updste o poss Mas vaioely |
1
2 0 0
3 0 0
4 ] 0
] 0 0
: " S (B
T 0 0 -
£} 0 0
D |1 il T [y
[ Maw 2 papen [Dnaivesher=500 5 Aoiaobeese=130]
i Wadocity |.:| [ M 3 i pipe (Diamesber=76 2. Aosgbess=130]
T Mew 4 i pipe [Disrster=101 5. Aoughrese=130]
Wax Valoely i [ Mew Ein pipe [Dismeter=152 4, Foughres=130]
1 Mew Binpipe [Dismeter=203 2, Aoughress=1 30|
C1Mew 10in pipe [Disrebera254, Aoughrezsa] 30]
™ Design Upcate I [1Mew 12 inpipe [Dismebers304.8, Aoughness=130] d|
Selsct Al

13. Click each row in the table and check the “design” check box and click the
“Select all options button”, then click the “Update” button.

14. Since there are no velocity limitation for the pipes click the “Update all pipes
Max velocity” and enter a high value — 1000.
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Pipez Dresmgn M anagei

Fipe 1D Hin velocily | Max, velocily

bl Mew & papa [Diameber=50 5. Hougbress=1.30]

Hin Vialoiciy Ig A M 3 i pipe ([Diaiveter=TE 2. Aodigbeee=130]
W Mew 4 inpipe (Diamsber=101 6. Aougheezs=130]
M Velocly I— W Mew E in pipe [Dismeter=152 4, Roughress=130]
105 | Mew B in pipe. [Dismeter=203 2, Aoughress=130]
¥ Mew 10 i pipe [Dismeters254, Foughresss130]
R Desgn Update | W Mew 12 in pipe [Dismeber=304.8, Aoughress=130] =
Selact 4l

15. Click the “OK” button.

16. To enter the optimization options select “Optimization Options” from the

“Design Option” menu and change the “Pressure Penalty” to 100,000. Click the
“OK” button:

-15 -



Optimization Parameters

100000

200000
200000

500000

™
o
o
e

:

17. Before we run the design process save the project.

18. Enter the “Run Design” dialogue by selecting “Run” from the “Design” menu

and click the “Run” button.
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Run Deszign

Mumber of genetics rinz
Run

Curment genetic run

b4 ) ) i W

Current generation

]
L
36
Curment best fitheszs -

Best feazible zolution

Fun progreszs

Curment genetic run progress

19. After the design process ends you may view the results by clicking the “Results”

button.

Note: the best solution known for this problem with a single diameter for each pipe

is 419,000 cost unit. optiDesigner reaches this solution almost every run!
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How to use optiDesigner

The first step in using optiDesigner is to build the water distribution system (system) to
be designed. The drawing and properties entry for the system is done with the EPANET

hydraulic simulation software so make sure you have it installed properly.

System building

You begin building the system by starting EPANET and using its graphical user
interface. For information on how to use the EPANET software please refer to the

EPANET user manual that could be download from the EPANET web site at:

http://www.epa.gcov/ORD/NRMRL/WSWRD/epanet.html

In general, you must build and enter legal data for all the system components: junctions,
pipes, tanks, reservoirs and valves. For pipes to designed you must enter default legal
data (like diameter = 10” and roughness = 100). Note that the length of the pipes being
designed are known and should be entered correctly. Since optiDesigner can design
only pipes, all other system components must be entered as they are. There are no

limitations on the system; it can even be built as an extended period simulation (EPS).

After you build the system, test it by running a simulation within EPANET. To run a
simulation, click the “Run Analysis” option in the “Project” menu within EPANET. If
the run ends successfully you are fine and set to go. If the run ends with errors, you
must correct the system and test it again. You may get some warnings when you run the

simulation, that is OK but double check to see if you made no mistake.

Note: the simulation must end with no errors!

After the system has been tested with no errors it is time to export the system as an INP
file. INP file is an ASCII file that holds all of the system information (it can viewed and

edited with any text editor like NotePad). To export the system, select “Export >
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Network” from the EPANET “File” menu. A save dialogue will pop up and you can
select the file name and path for the INP file. Save the file in a directory where you

want to run the design project.

Now it is time to quit the EPANET program and start the optiDesigner software.

Making a new project

After the system has been built and exported to an INP file you can start a new
optiDesigner design project. From the “File” menu click “New”. You will be prompt to
select the INP file you have prepared. Select it and click “Open”. If there are no error in

the INP file the network will be shown on the screen:

£ pptiDesigner - [Map] =10 x|
File Deszsign Optionz  Run
D D] m|o[~] | »|%]

e 7 P T =

7 [

€ 7 i

5 a

< 3 %

Note: you can not edit or change the system from within optiDesigner. All changes

must be done from EPANET.
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It is a good time now to save the design project by clicking the “Save” option from the
“File” menu. You will be asked to give the design project a name and a path (the file

will have the “OD” extension.

You must save the design project in the same directory you have placed the INP file. If
you wish to move the design project to another directory you must copy the design

project and the INP file to the same directory.

Note: the design project file (*.OD file) and the INP file must be in the same

directory.
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Entering the design options

The design options are a set of records that each represents pipe characteristics
(diameter, roughness and cost). Later on we will chose the design options that are
available for each pipe being designed. You may consider the design options as a kind

of extended pipes catalogue. You enter the design option dialogue by clicking “Design

Manager” from the “Design Options” menu:

& Dezign Manager

Add B ow Delete Row
Cost For
1D Description pipe unit | Diameter Hu:gg;;ess
length )

Dot Mew 1 in pipe 2 254 130
Doz Mew 2 in pipe 5 A0.8 130
Do3 Mew 3 in pipe 8 762 130
Do4 Mew 4 in pipe 11 101.E 130
DOs 152.4
DOE Mew 8 in pipe 23 203.2 130
Dov Mew 10 in pipe 32 254 130
DO# Mew 12 in pipe 50 304.8 130
DoA MNew 14 in pipe B0 KialaNs 130

D D05

Description I Mew B in pipe

Diarneter

Roughhess coeff.

Cost for pipe unit length 16

1524

1]

130

pdate |

Export ..

[rport ...

Ok

Cancel

If this is a new project, the design manager will be empty. The table consists of 5

columns:

e ID - an auto generated unique id;

e Description - a free text that describes the design options;

e Cost per unit length — unit cost of pipe;

e Diameter — pipes diameter;

® Roughness — pipes roughness.
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To add a record click the “Add Row” button. To remove a record, first select it by

clicking its row and then click the “Delete Row” button.

To enter data or change data, select a record by clicking on its row. The record will be
highlighted and the record data will be shown in the text boxes on the bottom of the
dialogue. After data entry\change click the “Update” button the update the record.

You can export the data you entered to a file in order to use it in another design project

by clicking the “Export” button. To import a saved data set, click the “Import” button.

After finishing editing the design options click the “OK” button or click the “Cancel”

button to discard any changes made.
Note: you must enter at least two design options and no field can be left empty.

Note: if you enter a zero value for the diameter parameter the design option will be

a closed pipe!

Selecting pipes design options

In this dialogue you assign design options to pipes you want to design and their velocity
constraints. To enter the pipes design manager click “Pipes” from the “Design
Options” menu. The manager holds a table with all of the systems pipes. To select a
record in the table click on the records row. The record data will be shown in the text
boxes on the bottom of the dialogue. At this point you can edit \change the record data.
If you want to select a pipe for design, check the “Design” box. To select the design
options for the pipe, check all relevant options in the list. Click the “Update” button to
except the changes. If you selected the pipe to be designed the “ID” field will be painted
in cyan. To change the minimum or maximum velocities for all pipes use the “Update

all pipes Min velocity” and “Update all pipes Max velocity” buttons.

When you are done editing click the “OK” button or the “Cancel” button to discard all

changes.

Note: pipes that are not selected for design will keep their properties that you used

when you built the system with EPANET.

Note: the velocity units used in this dialogue are the ones that you used when you
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built the system with EPANET.

Note: Each pipe you want to design must have two or more design options

associated with him.
Note: you must select at least one pipe to be designed.

Note: if you want to select a pipe for design but don’t want it to have a minimum
or maximum velocity constraint, enter 0 for the minimum velocity and a large

number for the maximum velocity (999999).

%} Pipez Design Manager ;lglil

lpdate all pipez Min velocity

Pipe 1D Min. velocity Max. velocity

Update all pipes tax velocity

1
2
3
4
h
b OE Cancel
¥
8
1D 4 Mew 1 in pipe [Diameter=25.4, Roughnesz=130]
Mew 2 in pipe [Diameter=50.8, Roughness=1230]
Min Yelozity EI— Mew 3 in pipe [Diameter=76.2, Roughnesz=130]
Mew 4 in pipe [Diameter=101.5, Roughness=130]
bl 2= Welocity s Mew B in pipe [Diameter=152 4, Roughnesz=130]
Mew 8 in pipe [Diameter=203.2, Roughness=130]

_ Mew 10 in pipe [Diameter=254, Roughneszs=130]
v Design Update | MNew 12 in pipe [Diameter=304.2, Roughness=130) |

Select all options |

Entering junctions constraints

With the “Junctions Design Manager” you can specify which junctions in the system
have pressure constraints? Each junction in the system can have a minimum and

maximum pressure constraint. To open the dialogue click “Junctions” from the
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“Design Manager” menu:

£} Junctions Design Manager : - |I:I|5|

Ilpdate all junctions Min pressure

Junction ID Min. pressure Max. preszure
Ilpdate all junctions Max preszure

2 30
3 30
4
0]
5 30 4
[} 30 .
7 a0 Min Pressure an
M ax Pressure 100
v Design I pdate
Ok Cancel

The table shows a list of all junctions in the system and their minimum and maximum
pressures allowed. To select a record, click on the record row. The record data will be
shown in the text boxes on the left. At this point you may edit the data. If you want that
the junction you have selected will “be designed” (have pressure constraints) check the
“Design” box. To update the data click the “Update” button before continuing with the
next junction. If you selected the junction to be designed the “ID” field will be painted
in cyan. To change the minimum or maximum pressures for all junctions use the
“Update all junctions Min pressure”’ and “Update all junctions Max pressure”

buttons.

When you are done editing click the “OK” button or the “Cancel” button to discard all

changes.

Note: the pressure units used in this dialogue are the ones that you used when you

built the system with EPANET.

Note: if you want to select a junction for design but don’t want it to have a
minimum or maximum pressure constraint, enter a large negative number for the
minimum pressure (-999999) and a large number for the maximum pressure

(999999).
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Entering sources constraints

In the “Sources design Manager” you may specify whether one or more of the system
sources have a flow constraint. This option may be used, for example, when you have a
water well with limited pumping equipment available. A source of the system is any
reservoir defined in the EPANET software (by the way, a reservoir is a good way to
simulate a well). Each source in the system can have a maximum flow constraint

(discharge). To open the dialogue click “Sources” from the “Design Manager” menu:

ources Deszign Manager =10l x|

Source 1D

0] 1

1 b ax. Flow 0

[T Design Update |

The table shows a list of all sources to the system and their maximum flow allowed. To
select a record, click on the record row. The record data will be shown in the text boxes
on the left. At this point you may edit the data. If you want that the source you have
selected will “be designed” (have flow constraints) check the “Design” box. To update
the data click the “Update” button before continuing with the next source. If you

selected the source to be designed the “ID” field will be painted in cyan.

When you are done editing click the “OK” button or the “Cancel” button to discard all

changes.

Note: the flow units used in this dialogue are the ones that you used when you built

the system with EPANET.
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Optimization parameters

There are nine parameters that control the optimization process of optiDesigner. To edit
the optimization parameters select the “Optimization Options” from the “Design

Options” menu:

£ Dptimization Parameters EI
~Penaltie
Pressure Penalty 200000
Welocity Penalty 200000
Sources Penalty 200000
WwamingPenalty 00000
~Genetic Algarithm
Population Size 100
Mo. of Generationz 500
Mo. of Generationz with no change a0
~Tolerance
Freszure tolerance 0.05
telocityT ol 0.05
s |

There are three groups of parameters in this dialogue box:

Penalties

The penalties are the most important parameters in the optimization process. The
objective function of the process is minimization of the total pipe cost. Of course, it is
possible to lower the cost if the constraints are not satisfied (pressures, velocities and

sources flows) so the algorithm must take the violation of these constraints into account.
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The way to do that is to introduce a penalty upon a constraint violation. There is a

penalty for each kind of constraint:

Pressure penalty — the penalty for each unit of pressure constraint violation. The

default penalty is 200,000.

Velocity penalty — the penalty for each unit of velocity constraint violation. The default

penalty is 200,000.

Sources penalty — the penalty for each unit of flow constraint violation. The default

penalty is 200,000.

Warning penalty — a penalty that is introduced when the hydraulic solver reports a

warning. The default penalty is 500,000.

Note: how to set the penalties is the million-dollar question. There is no simple
answer for it. In most cases it will take some time with trail and error process to
get the penalties that produces the best results. Penalties that are too small won’t
effect the solution and there will be constrains violations. On the other hand, large
penalties will have the opposite effect. The solution may be feasible but the cost will
be high. The penalties would “chock” the algorithm. So what to do? Start with a
low set of penalties that probably won’t give you a feasible solution. Then increase
the penalties until you get a feasible solution. Try changing one penalty at a time to

see how it effects the solution.

Genetic algorithms

The next three parameters are genetic algorithms related (see the genetic algorithm

chapter):

Population size — the number of individuals in the genetic population. The default

value is 500. This value must be an even number greater then 2.

Number of generations — the maximum number of generation the population is

allowed to evolve. The default value is 500

Number of generations with no change — the number of generation the population is
allowed to evolve with no change in the best fitness (the minimal design cost). The

default value is 50.
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Tolerances

The pressure and the velocity constraints are many times very tight. It is best to have a

small tolerance with these constraints:

Pressure tolerance — the tolerance for the pressure constrains. The default value is

0.05.

Velocity tolerance — the tolerance for the velocity constrains. The default value is 0.05.

Running a design simulation

Once the problem had been defined it is time to run a design simulation. To open the
“Run Design” dialogue, select “Design” from the “Run” menu. The only parameter to
be set before the “Run” button should be clicked is the “number of genetics runs”. This
parameter controls the number of genetics design processes that will be made. Since the
genetic algorithm doesn’t guarantee a global optimum, several runs should be made in
order to get a good solution. The default value is 5 runs. Once this parameter is set you

can start the design process. In the main frame of the dialogue there are four fields:
e Current genetic run — the current run out of the “number of genetics runs”.

e Current generation — the current genetic generation within the current genetic

run.

e Current best fitness — the best fitness within the current genetic run. If the
current best fitness is feasible then the background of the text box will be painted

green. If not, the background will be painted red.

e Best feasible solution — the best overall feasible solution reached.
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Run Deszign

Mumber of genetics rinz

Curment genetic run

b4 ) ) i W

Current generation

Hezults
Curment best fitheszs

' . Cloze
Best feazible zolution -

Fun progreszs

Curment genetic run progress

While the design process is on, the progress bars on the bottom of the dialogue show its

progress.

The run can be stopped by clicking the “Stop Run” button.

Run Design

Mumber of genetics rinz 5

Eun
Current genetic run 5
Current generation 103

Hezults
Curment best fitheszs

Best feazible zolution

- -

Fun progreszs

Curment genetic run progress
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At the end of the design process you will be prompt whether a feasible solution was

found or not.

Viewing results

Once the design process comes to end and a feasible solution has been found, you can
view the design results by clicking the “Results” button in the “Run Design” dialogue,

or select “Results” from the “Run” menu.

The dialogue shows the results for the pipes, junctions and sources.

&} Optimization results X|

1D Design dezcription Cost "'.F':I‘I;::l:-ity v::l:::ity
10 Mew 16 in pipe 252,930 278
11 Mew 12 in pipe 269,280 054
12 Mew 10 in pipe 232,320 016
21 Mew 12 in pipe 269,280 n.09
22 Mew 8 in pipe 130,020 0.3g
g1 Mew 8 in pipe 130,020 n1g
110 Mew 16 in pipe 16,200 0.05
111 Mew 12 in pipe 269,280 0.37
112 Mew 10 in pipe 232,320 INR
113 Ma Pipe
121 MNew & in pipe 130,020 026 1.20
122 MNew & in pipe 130,020 0.05 n.e4
Total 2.901.930

Save results to INP file

Save design results to file
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Optimization results x|

1D Min. Pressure Max. Pressure

11 107.54 124.76
12 11273 125.58
13 114.76 127.54
21 111.39 12589
22 11352 126.85
23 114.87 127,77
31 11095 124.66
32 10E.65 12018

The results can be saved in to ways:

e Save results to INP file — the results are saved to an INP file that can be opened

by the EPANET software.

e Save design results to file — the content of the results dialogue are saved to an
ASCII file that can be viewed by any text editor or can be imported to any
spreadsheet like Microsoft Excel.
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Data files
Each design project consist of two files:

e INP file — the EPANET program created the INP file. After you build the system
with EPANET you have to export it to an INP file.

e OD file — this file holds the design data. It is build by optiDesigner and must be

saved in the same directory as the INP file!

If you want to move the project to a different directory you have to copy\move both

files to the new location.
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Regqistration Utility

As explained in the license chapter, the evaluation copy of optiDesigner can be used for
only 30 days. After that, if the user would like to keep using optiDesigner, he should

register the software.

Registration

Registering optiDesigner is easy to do at:

http://www.optiwater.com/optidesigner/register.html

Before you begin the registration process run the registration utility that is located in the
optiDesigner program group (the “REGISTER.EXE” file is located in the same

directory you installed optiDesigner).

i, optiDesigner Registeration Winlky ﬂ
Code A SBRERE 43-2BES4F 34
Code B

Reqister |

Type "YES™ to transfer IND

Tiranefen Begatratian |

Code C

Code D

E =it

The utility will provide you a code called “Code A”. You will be asked to provide this
code during the registration process. After your registration will be approved you will
receive a confirmation code “Codes B” which you will have to enter in the registration

utility and click the “Register” button.
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That is it!

. optiDeszigner Registeration Wtnlk x|
Code A REEREEAB-2BEBAF 34
Code B KNATE004EpS

Eeqister |

Type "YES" to tranzfer IND

Transfen Begatratian |

Code C
Code D

E =it

Transferring the license

If you would like to transfer the license to a different computer you should follow these

steps:

—_—

Install optiDesigner on the target computer.

2. Run the registration utility on the target computer and copy the first registration

code — “Code A”.

3. Run the registration utility on the source computer (the computer where the

optiDesigner is registered) and type the word “YES” in the transfer text box.

4. You will be asked to enter the code you copied from the target computer. It will

be entered as “Code C”.

5. A new code will be shown in the “Code D” text box. Use this code as “Code B”

for the target computer.
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i, optiDesigner Registeration Winlky X|

SEEBEE45-1 2444269

DEMO-CODE
yRI1LE1yhlzca

———

After you transfer the registration to the target computer optiDesigner will not work on

the source computer.
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Contacts and Registration

Registration

Registering your own copy of optiDesigner is easy to do at:

http://www.optiwater.com/optidesigner/register.html

You will be given all the payment options:
e Secure online credit card payment
e Purchase Orders
e Mail orders

Full details are found on the site.

Contacts

The best place for information is the optiDesigner web site at:

http://www.optiwater.com/

Or you can mail me at: support@optiwater.com with requests for information, technical

assistance or bug reports.
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